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Warranty

 

Printer Warranty

 

Tektronix warrants that the Phaser 850 Printer will be free from defects in materials and 
workmanship for a period of one (1) year from the date of shipment.  If the product 
proves defective during the warranty period, Tektronix, at its option, will:

(1) repair the product by means of telephone support or on-site service at no charge for 
parts or labor, 
(2) replace the product with a comparable product, or 
(3) refund the amount paid for the product, less a reasonable allowance for usage, upon 
its return. 

Under this product warranty, Customer must notify Tektronix or its authorized service 
representative of the defect before the expiration of the warranty period.  To obtain 
service under this warranty, the Customer must first contact Tektronix Telephone 
Support personnel or that of its authorized service representative.  Telephone Support 
personnel will work to resolve issues professionally and quickly, however the Customer 
must reasonably assist Tektronix or its authorized representative.  

If telephone support is unsuccessful, Tektronix or its authorized service representative 
will provide warranty repair at Customer's site without charge as provided below.  

 

�

 

Service is available anywhere within the United States for products purchased in 
the United States

 

�

 

Inside the European Economic Area, service is available within the customary 
on-site service area for products purchased in the EEA

 

�

 

Outside the US & EEA, service is available within the customary on-site service 
area in the country of purchase

A description of the customary on-site service area may be obtained from the local 
Tektronix subsidiary or authorized Tektronix distributor.  On-site service is at Tektronix 
or its authorized service representative’s sole discretion and is considered an option of 
last resort. 

If the Customer’s product contains features that enable Tektronix or its authorized 
service representative to diagnose and repair problems with the product remotely, 
Tektronix may request that Customer allow such remote access to the product.

In the maintenance of the product, Tektronix may use new or equivalent to new parts or 
assemblies for equal or improved quality.  All defective parts and assemblies become the 
property of Tektronix.  Tektronix, at its option, may request the return of these parts.

  

 



 

Consumables Warranty

 

 

Tektronix warrants that the Customer Replaceable Consumables (CRCs) will be free from 
defects in materials and workmanship for a period of ninety (90) days (six  (6) months 
where longer periods are required by law) from the date of installation, but not more 
than one (1) year from date of shipment.  Under this warranty, the Customer must notify 
Tektronix or its authorized service representative of the defect before the expiration of 
the warranty period.  TEKTRONIX MAY REQUIRE THAT THE DEFECTIVE CRC BE 
RETURNED TO A DESIGNATED TEKTRONIX DEPOT OR THE TEKTRONIX 
REPRESENTATIVE FROM WHICH THE CRC WAS ORIGINALLY PURCHASED.  Claims 
will be handled according to the current Tektronix procedure.

These warranties shall not apply to any defect, failure or damage caused by improper 
use or improper or inadequate maintenance and care. Tektronix shall not be obligated 
under these warranties: 

a) to repair damage resulting from attempts by personnel other than Tektronix 
representatives to install, repair or service the product unless directed by a Tektronix 
representative; 
b) to repair damage, malfunction, or degradation of performance resulting from 
improper use or connection to incompatible equipment or memory;
c) to repair damage, malfunction, or degradation of performance caused by the use of 
non-Tektronix printer supplies or consumables or the use of Tektronix supplies not 
specified for use with this printer;
d) to repair a product or CRC that has been modified or integrated with other products 
when the effect of such modification or integration increases the time or difficulty of 
servicing the product or CRC;
e) to perform user maintenance or cleaning or to repair damage, malfunction, or 
degradation of performance resulting from failure to perform user maintenance and 
cleaning as prescribed by Tektronix in its published materials;
f) to repair damage, malfunction, or degradation of performance resulting from use of the 
product in an environment not meeting the operating specifications set forth in the user 
manual;
g) to repair this product after the limit of its duty cycle has been reached; all service 
thereafter shall be billed on a time and material basis;
h) to replace CRCs that have been refilled, are used up, abused, misused, or tampered 
with in any way.

THE ABOVE WARRANTIES ARE GIVEN BY TEKTRONIX WITH RESPECT TO THIS 
PRODUCT AND ITS CUSTOMER REPLACEABLE CONSUMABLES IN LIEU OF ANY 
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS 
DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 
A PARTICULAR PURPOSE OR ANY SIMILAR STANDARD IMPOSED BY APPLICABLE 
LEGISLATION. TEKTRONIX' RESPONSIBILITY TO REPAIR, REPLACE, OR OFFER A 
REFUND FOR DEFECTIVE PRODUCTS AND CUSTOMER REPLACEABLE 
CONSUMABLES IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE 
CUSTOMER FOR BREACH OF THESE WARRANTIES. TEKTRONIX AND ITS 
VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES (INCLUDING LOSS OF PROFITS) IRRESPECTIVE OF 
WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE 
POSSIBILITY OF SUCH DAMAGES. 



 

For the software warranty please see the end user license agreement included with the 
software.

If you are an Australian consumer, you should be aware that the Trade Practices Act 
1974 and equivalent State and Territory legislation (collectively "the Acts") contain 
special provisions designed to protect Australian consumers.  Nothing in any Tektronix 
warranty material excludes or limits the application of any provision of any of the Acts, 
where to do so would contravene the Acts or cause any part of this warranty to be void.  
In this warranty material, an implied condition or warranty, the exclusion of which from 
a contract with a "Consumer" (as defined in the Acts) would contravene any provision of 
the Acts or cause any part or all of this warranty to be void, is called a "Non-excludable 
Condition".  To the full extent permitted by law, Tektronix’s sole and total liability to the 
customer for a breach of any Non-excludable Condition (including for any consequential 
loss suffered by the customer) is limited, except as otherwise stated herein, to (at 
Tektronix’ option) replacing or repairing the goods, or resupplying, or paying the cost of 
the resupply of, the services, in respect of which the breach occurred.  Subject to the 
above, all conditions and warranties which would or might otherwise be implied in a 
Consumer contract, whether by operation of statute, inference from circumstances, 
industry practice or otherwise, are excluded.  



 

User safety summary

 

Terms in manual: 
Caution: 

 

 Conditions that can result in damage to the product.  

 

Warning:

 

  Conditions that can result in personal injury or loss of life.

 

Use proper power source:  

 

Do not operate this product from a power source that applies 
more than the voltage specified.  To avoid fire hazard, use only the power cord specified 
for this product.  In hospital applications, grounding reliability can only be achieved by 
the use of a hospital grade power cord, and the equipment is connected to an equivalent 
receptacle marked “hospital only” or “hospital grade.”

 

Operation of product: 

 

 There are no user-serviceable parts inside the product.  Avoid 
electric shock by contacting a qualified service technician to repair the product.  Do not 
operate without the covers and panels properly installed.  Do not operate in an 
atmosphere of explosive gases or flammable mixtures.

 

Safety instructions: 

 

 Read all installation instructions carefully before you plug the 
product into a power source.

 

Terms on product: 

 

CAUTION:  A personal injury hazard exists that may not be apparent.  For example, a 
panel may cover the hazardous area.  Also applies to a hazard to property including the 
product itself.
DANGER:  A personal injury hazard exists in the area where you see the sign.

 

Care of product: 

 

 Disconnect the power plug by pulling the plug, not the cord.  
Disconnect the power plug if the power cord or plug is frayed or otherwise damaged, if 
you spill anything into the case, if product is exposed to any excess moisture, if product 
is dropped or damaged, if you suspect that the product needs servicing or repair, and 
whenever you clean the product.

 

Ground the product: 

 

 Plug the three-wire power cord (with grounding prong) into 
grounded AC outlets only.  For protection against electric shock, this product is 
classified Class I, and Type B where applicable.

 

Location of product: 

 

 Place the printer in a well-ventilated area.



 

Symbols as marked on product:

 

DANGER high voltage: 

 

  

 

Protective ground (earth) terminal:  

 

 

 

Hot surface on or in the printer.  Use caution to avoid personal injury: 

 

 

 

Use caution.  Refer to the manual(s) for information:

 

  

 

Warning

 

If the product loses the ground connection, usage of knobs and controls (and 
other conductive parts) can cause an electrical shock.  Electrical product 
may be hazardous if misused.  

 

Warning

 

For your protection, do not defeat any interlocks.
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Tektronix supplies and accessories 

 

To order supplies and accessories, contact your local dealer or visit the 
Tektronix web site:

 

www.tek.com/Color_Printers/products/supplies.html 

 

  

 

ColorStix Ink      

 

Item Part Number

 

3 Free Black sticks 016-1831-00

5 Cyan sticks plus 2 Free Black sticks 016-1825-00

5 Magenta sticks plus 2 Free Black sticks 016-1826-00

5 Yellow sticks plus 2 Free Black sticks 016-1827-00

2 Cyan sticks plus 1 Free Black stick 016-1828-00

2 Magenta sticks plus 1 Free Black stick 016-1829-00

2 Yellow sticks plus 1 Free Black stick 016-1830-00

 

Tektronix Paper       

 

Item Size Description Part Number

 

Premium Color 
Printing Paper

A/Letter (U. S.) 
8.5 x 11 in. 

500 sheets 
24-lb. bond, 90 g/m

 

2

 

016-1368-00

Premium Color 
Printing Paper

A4 (Metric)
210 x 297 mm 

500 sheets 
24-lb. bond, 90 g/m

 

2

 

016-1369-00

High Resolution 
Photo Paper

A/Letter (U. S.)
8.5 x 11 in.

25 sheets
170 g/m

 

2

 

016-1808-00

High Resolution 
Photo Paper

A4 (Metric)
210 x 297 mm 

25 sheets
170 g/m

 

2

 

 

 

016-1809-00

Premium Cover A/Letter (U. S.)
8.5 x 11 in.

100 sheets 
60-lb. cover, 160 g/m

 

2

 

016-1823-00

Premium Cover A4 (Metric)
210 x 297 mm 

100 sheets
60-lb. cover, 160 g/m

 

2

 

016-1824-00
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Transparencies      

 

Item Size Description Part Number

 

Premium A/Letter (U. S.)   
8.5 x 11 in.

50 sheets 016-1724-00

Premium A4  (Metric Letter)
210 x 297 mm 

50 sheets 016-1725-00

Standard A/Letter (U. S.) 
8.5 x 11 in.

50 sheets 016-1720-00

Standard A4  (Metric Letter)
210 x 297 mm 

50 sheets 016-1721-00

 

Color Printing Labels  

 

Size Description Part Number

 

A/Letter (U. S.)  
8.5 x 11 in.

100 sheets / 30 labels per sheet 
(each 1 x 2-5/8 in.)

016-1812-00 

A/Letter (U. S.)  
8.5 x 11 in.

100 sheets / 6 labels per sheet 
(each 3-1/3 x 4 in.)

016-1813-00

A4  (Metric Letter)
210 x 297 mm

100 sheets / 14 labels per sheet 
(each 38.1 x 99.1 mm)

016-1814-00

A4  (Metric Letter)
210 x 297 mm

100 sheets / 8 labels per sheet  
(each 67.1 x 99.1 mm)

016-1815-00

 

Maintenance Kit    

 

Item Part Number

 

Extended replacement maintenance roller and counter 
(Life: up to 45,000 images or two years, which ever comes 
first.) 

016-1834-00

Standard replacement maintenance roller and counter 
(Life: up to 10,000 images or two years, which ever comes 
first.)  

016-1822-00
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Replacement items    

 

Item Part Number

 

Maintenance Waste Tray (replacement) 436-0370-01

Maintenance Drawer (replacement) 436-0383-00

Rapid Release Guide 650-4153-00

 

Additional memory 

 

Features Part Numbers

 

�

 

Improved performance

 

�

 

Up to 256 Mbytes maximum

 

�

 

64 Mbytes:  ZMB64

 

�

 

128 Mbytes: ZMB128

The printer has two memory slots.  When adding memory,  you can use 
64-Mbyte and 128-Mbyte DIMMs in combination.

 

Trays   

 

Size Description Part Number

 

Standard Paper/Transparency Tray A/Letter (U. S.) 436-0330-00

Standard Paper/Transparency Tray A4 (Metric Letter) 436-0332-00

High-Capacity Transparency/     
Label Tray

A/Letter (U. S.) 436-0336-00

High-Capacity Transparency/Label 
Tray

A4 (Metric Letter) 436-0338-00

 

Cleaning Kit  

 

Item Part Number

 

Package of 5 alcohol wipes 016-1845-00
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High-Capacity Paper Tray Assembly 

Features Part Numbers

� Increased paper-printing capacity

� Increased printing versatility and 
convenience

� Up to two High-Capacity Paper Tray 
Assemblies can be used

� U. S.:  Z840LTA

� Metric:  Z840LTA Option 01 

Printer Station       

Features Part Number

� Ergonomic surface height

� Provides storage for supplies

ZCARTA

Internal IDE Hard Drive 

Features Part Number

� Required for collation     

� Extends font capacity

Z850HD

DP Feature Set     

Features Part Number

� High Resolution / Photo print-quality 
mode, 1200 x 600 dpi

� Automatic two-sided printing 
capability

� Adds 32 Mbytes of memory (64 Mbytes 
total)

� 1st Page Preview functionality

� Quick Collate functionality (requires a 
hard drive)

� Page Pipelining 

Z850FP
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PhaserShare® Network Card 

Features Part Number

� Easy to install

� Increases shareability

� High-performance network connectivity

Token Ring:  ZNBTR
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The front panel
� Provides access to printer settings (tray, print-quality mode, 

network settings, etc.).

� Displays the printer’s operating status (Ready to Print, Printing).

� Alerts you to replace consumables, load paper, and clear jams.     

?

1

2

7 6

5
43

Help Select

Phaser 850 DX
READY TO PRINT

Menu
About my Printer 
Help
Printer Demo

0643-79A.ai
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Key
1. Error indicator

2. Power indicator

3. Printer model and current status

4. Display

� Menu:  Accesses printer setup menus 

� About My Printer:  Displays current printer settings and 
information

� Help:  Accesses information and tools for solving printer 
problems

� Printer Demo:  Prints sample images and color charts 

5. Navigation arrows. Use the arrows to scroll the front panel menus.

6. Select button.  Selects highlighted settings. 

7. Help button.  Press at any time for additional information on 
displayed menu options or status messages.   

Printing a Menu Map

The Menu Map shows you where features such as the help pages, are 
located in the front panel’s menu structure.  

1. Scroll to Menu, press Select.

2. Scroll to Print Menu Map, press Select.

  

Front Panel
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Print quality modes

 *Approximate number of pages per minute; does not include image 
processing time.  Based on prints with margins of .5 in. or greater.  
**Transparencies are printed in Standard mode.

Print quality modes selectable from a 
printer driver or the front panel

Maximum speed*

Fast Color    

� Fastest full-color output.

� Useful for many images and previewing 
work. 

� Produces good peer-level documents.

� Useful for rush jobs when saturated 
colors are not necessary.

14 ppm Paper        

6.5 ppm  Transparency 

Standard    

� General-purpose mode for 
full-color printing.

� Best quality mode for printing 
transparencies.

� Suitable for most office uses.

� Produces vibrant, saturated prints with 
smooth color transitions.

8 ppm Paper

3.5 ppm Transparency

Enhanced**      

� Superior text resolution and 
very smooth light colors.

� Balance of high quality and fast speed.

� Smoothest and brightest large-area fills.

� Useful for printing paper copies of 
overhead presentations.

4 ppm Paper

High Resolution/Photo**                

� Highest-quality color prints.

� Near-photographic detail.

� 1200 x 600 dpi.

� Requires DP or DX Feature Set.

2 ppm  Paper

 

Fe
at
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TekColor™ color corrections
Color corrections 
selectable from a 
printer driver or the 
front panel

Description

Automatic      � Automatically applies the best color correction 
mode to each element on the page

None       � No color correction made to colors

� Used with the PANTONE® Color Chart for 
PANTONE® Color matching

Vivid Color       � Produces the brightest possible colors and makes 
blues appear less purple

sRGB Display       � Closely approximates the colors on a standard 
display screen

SWOP Press       � Specification for Web Offset Publications.  Used 
to match U. S. press standards

Euroscale Press       � Used to match equivalent Imation Matchprint® 
proofs

Commercial Press       � Used to match commercial Imation Matchprint® 
proofs

SNAP Press       � Specifications for Non-Heat Advertising Printing

� Used to match standards for printing on uncoated 
and newsprint papers

DIC       � Used to match Dai Nippon printing inks on 
coated paper

Toyo       � Used to match commercial Toyo printing inks on 
coated paper

FujiProof       � Used to match the Fuji Color Art System for 
commercial North American proofs

Black and White       � Grayscale printing

� Used to print page masters for photocopying in 
black-and-white



10 Phaser 850 Color Printer 

Paper tips
� Print the Paper Tips Page from the printer’s front panel for a 

detailed list of paper types and sizes.    

� When you select a tray by location (Upper, Middle, Lower) from a 
printer driver, the printer feeds from that tray. 

� Always keep stored paper, transparencies, and labels, in sealed 
packages to avoid the effects of moisture which can affect feed 
reliability.

� Always use the manual-feed slot for heavy paper and envelopes.

� Handle transparencies by the edges and with both hands to avoid 
fingerprints and creases, which can result in poor print quality.

� Do not use three-hole punched paper, perforated paper, or an 
unsupported paper size.  
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Supported page sizes and print area

The image area of a print is a bit smaller than the paper size.  You may 
need to adjust the page margins in your application software to match 
the print area.  

To print from a supported driver, select Print.  Select Page Size.  
Choose one of the following sizes.      

*Transparencies available in Letter- and A4-sizes only.  

Paper* Page size Print area Top/ 
Bottom 
margins

Left/ 
Right 
margins

1. Letter 8.5 x 11 in. 8.112 x 10.612 in. .2 in. .2 in.

2. Executive 7.25 x 10.5 in. 6.85 x 9.95 in. .275 in. .2 in.

3. A4 210 x 297 mm 200 x 287 mm 5 mm 5 mm

4. A5    148 x 210 mm 138 x 196 mm 7 mm 5 mm

4321

0643-65.ai

 

Paper Tips
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Caution

Never use envelopes with windows or metal clasps; they will 
damage the printer.  Use only the recommended envelope 
sizes.  Envelopes must always be placed with the flap 
face-up. 

For better results, use light-weight, laser-quality envelopes. 

  

Envelopes      Page size Print area Top/ 
Bottom 
margins 
(A/B)

Left/ 
Right 
margins 
(C/D)

#10 (U. S.) 4.13 x 9.5 in. 3.73 x 8.95 in. .2 in. .275 in.

#6 3⁄4  (U. S.) 3.65 x 6.5 in. 3.25 x 5.95 in. .2 in. .275 in.

Monarch (U. 
S.)

3.875 x 7.5 in. 3.475 x 6.95 in. .2 in. .275 in.

C5 162 x 229 mm 152 x 197 mm 5 mm 7 mm
25 mm 

DL 110 x 220 mm 100 x 206 mm 5 mm 7 mm 

Choukei 3 Gou 120 x 235 mm 110 x 221 mm 5 mm 7 mm 

Choukei 4 Gou 90 x 205 mm 80 x 191 mm 5 mm 7 mm 

A

B

C D

A

B

C D

0643-155
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Manual-feed printing 

Supported media

See page 1 for supplies ordering information.     

Paper

� Sizes:  

� A/Letter  

� Executive 

� A4

� A5 

� Bond or equivalent, 60 - 150 g/m2; 16 - 40 lb. 

� Heavy papers 150 - 216 g/m2:  for example, cover stock 
216 g/m2 or 80-lb.,  and index stock 110-lb.; single-sided 
printing only

� Coated or Glossy papers, single-sided printing only

� Short-grained paper, at least 105 g/m2 and up to 150 g/m2; 
28 - 40 lb. bond

� Tektronix Premium Cover, single-sided printing only

� Tektronix High Resolution Photo, single-sided printing only

Transparencies

� Sizes:  A/Letter and A4

� Use only Phaser 850 printer transparencies

Labels

� Sizes:  A/Letter and A4

� Use only Phaser 850 printer Color Printing Labels 

M
anual-Feed
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Envelopes

For better results, use light-weight, laser-quality envelopes. 

� #10 (U. S.) 

� #6 3/4  (U. S.)

� Monarch  (U. S.)

� C5 

� DL

� Choukei 3 Gou

� Choukei 4 Gou

Using the manual-feed slot for single-sided printing

To use the manual-feed slot for single-sided printing, follow these 
steps.  To use the manual-feed slot for two-sided printing, see 
Automatic two-sided printing on page 32.    

Note

Refer to page 34 for instructions on loading letterhead for 
two-sided printing.

1. In a supported printer driver, select Manual Feed Paper or 
Manual Feed Transparency.

� Make sure that two-sided printing is turned off in the 
printer driver.

2. To send the job to the printer, click Print.

 

M
an
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3. Open the manual-feed slot.

4. Align the paper, transparency, or envelope, with the left side of 
the slot.  For either Letter- or A4-size, adjust the guides on the 
right side of the slot.   

5. When the front panel reads Waiting for Manual Feed, insert one 
sheet or envelope until the printer pulls it in:

� Top of the page enters first.

� Side to be printed is face-down.

� To avoid jams, make sure the sheet or envelope is properly 
aligned as it enters the printer

� Check the first print to make sure the image placement is 
correct.  

6. Wait for the front panel’s prompt before inserting 
additional sheets.  

3 4

A4

0643-160

LETTERA4

5 6

0643-67
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Manual-feed speciality media overview
1. Letterhead or High-Resolution Photo 

See Loading letterhead paper for two-sided printing on page 34 
and Printing on High Resolution Photo Paper on page 29 for more 
information.  

2. Transparencies  

3. Labels
See Printing on labels on page 30 for more information.       

1234
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1. Envelopes
See Printing on envelopes on page 18 for more information. 

2. Executive/A5 small papers   

Caution

Never use envelopes with windows or metal clasps; they will 
damage the printer.  Only use the recommended envelope 
sizes.  Envelopes must always be placed with the flap 
face-up. 

0643-149
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Printing on envelopes
1. In your application, create a document matching the 

measurements of the envelope (see page 11 for dimensions).  

2. From your application, make these selections and send the job to 
the printer:

� Set the orientation to Landscape.

� Select your envelope size.

� Select Manual Feed Paper as the Paper Source. 

� If your application has a tool for creating envelopes, select 
the feed method that matches the illustration in Step 4.

3. Wait for the front panel prompt before loading an envelope.  

4. Insert one envelope into the manual-feed slot:  

� Short end enters first.

� Side with the flap is face-up.

� Flap is closed.  

� For side-flap envelopes:  Flap end is on the left.
For end-flap envelopes:  Flap end enters first.    

0643-97
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Guidelines for envelope printing
� Use the recommended envelope sizes (see page 11)

� For better results, use light-weight, laser-quality envelopes. 

� No windows or metal clasps

� No exposed gummed surfaces

� Single-sided printing only

� Keep unused envelopes in their original packaging to avoid dust

� Many applications include a tool for creating an envelope.  Refer 
to your application’s documentation.

Printing envelopes from a Macintosh

To print envelopes from Microsoft WORD on a Macintosh, follow 
these steps: 

1. From the Tools menu, select Envelopes and Labels.  

2. In the Envelopes and Labels dialog box, click the Envelopes tab.

3. In  the Envelopes tab, type in delivery and return addresses.  

4. Click the Feed icon.

5. In the Printing Options tab, select all of the following: 

� Face Down

� Clockwise Rotation

� Use Envelope Feeder

� Left envelope feed icon:    

0643-148.ai
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6. Click the Envelope Options tab.

7. In the Envelope size drop-down list, select your envelope size.  

8. Click OK.  

9. In the Envelopes and Labels dialog box, click Print to open the 
Page Setup dialog box.  

10. In the Page Setup dialog box, select all of the following 
Page Attributes:

� Paper:  select your envelope size.  

� Orientation:  select Landscape.  

11. From the drop-down list, select PostScript Options, and make the 
following selections:

� Flip Horizontal  

� Flip Vertical

12. Click OK; the Print dialog box opens.  

13. In the Print dialog box, in General options, for Paper Source 
select Manual Feed Paper.

14. Click Print.  

15. The printer’s front panel prompts you to insert the envelope.  
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From other Macintosh applications:  If the envelope address prints 
upside-down, change the Page Setup settings in your printer driver 
before printing:  

1. From the File menu, select Page Setup.

2. Select the following Page Attributes:

� Paper:  select your envelope size.  

� Orientation:  select Landscape.  

3. From the drop-down list, select PostScript Options, and make the 
following selections:

� Flip Horizontal  

� Flip Vertical

4. Click OK.  

5. From the File menu, select Print.

6. For Paper Source, select Manual Feed Paper.

7. To print, click Print.  
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Printing envelopes from Windows

To print envelopes from Microsoft WORD for Windows, follow 
these steps:  

1. From the Tools menu, select Envelopes and Labels.  

2. In the Envelopes and Labels dialog box, click the Envelopes tab.

3. In  the Envelopes tab, type in delivery and return addresses.  

4. Click the Feed icon.

5. In the Printing Options tab, select all of the following: 

� Face Down

� Clockwise Rotation

� For Feed From, select Manual Feed Paper.

� Left envelope feed icon:     

6. Click the Envelope Options tab.

7. In the Envelope size drop-down list, select your envelope size.  

8. Click OK.

9. In the Envelopes and Labels dialog box, click Print.  

10. The printer’s front panel prompts you to insert the envelope.  

0643-148.ai
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Loading the Standard Paper/ 
Transparency Tray

Supported media

See page 1 for supplies ordering information.     

Paper

� 200-sheet capacity

� Bond or equivalent, 60 - 150 g/m2, 16 - 40 lb.

� Heavy papers 150 - 176 g/m2, 40 - 65-lb.; for example, cover stock 
176 g/m2 or 65-lb.; single-sided printing only 

� Coated or glossy papers, single-sided printing only

� Short-grained paper, 105 - 150 g/m2,  28 - 40 lb. bond

� Tektronix Premium Cover, single-sided printing only

� Tektronix High Resolution Photo, single-sided printing only

� Set tray switch to Paper.  

Transparencies

� 50-sheet capacity

� Use only Phaser 850 printer transparencies 

� Set tray switch to Transparency.  

Labels

� 50-sheet capacity

� Use only Phaser 850 printer Color Printing Labels 

� Set tray switch to Paper.  

Trays
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Loading the tray
1. Use the tray’s maximum-capacity label to determine how much 

paper or transparency to load.  

2. Load paper with the side to be printed face-up.

� For single-sided printing, load letterhead paper with the top 
of the page at the front of the tray.

� For two-sided printing on letterhead, refer to page 34. 

3. Place the paper snugly against the inside left front wall of the tray.

4. Set the switch on the side of the tray for Paper or Transparency to 
match the loaded media.  If you are loading labels in the 
Paper/Transparency tray, set the tray switch to Paper. 

5. Insert the tray into the printer.     
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Loading the High-Capacity Paper Tray 
Assembly

Supported media

See page 1 for supplies ordering information.     

Paper only

� 500-sheet capacity

� Bond or equivalent, 63 - 120 g/m2, 17 - 32 lb.

� You can use up to two High-Capacity Paper Tray Assemblies with 
your printer. 

Loading the tray
1. Angle the paper stack to match the angle of the tray.  

2. Use the tray’s maximum-capacity label to determine how much 
paper to load.

3. Load paper with the side to be printed face-up.

� For single-sided printing, load letterhead paper with the top 
of the page at the front of the tray.

� For two-sided printing on letterhead, refer to page 34. 

4. Place the paper snugly against the inside left back wall of the tray.
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5. Insert the tray into the printer.  

0389-19
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Loading the optional High-Capacity 
Transparency/Label Tray

Supported media

See page 1 for supplies ordering information.     

Transparencies 

� 175-sheet capacity

� Use only Phaser 850 printer transparencies

� Set tray switch to Transparency.  

Labels

� 100-sheet capacity

� Use only Phaser 850 printer Color Printing Labels 

� Set tray switch to Label.  
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Loading the tray
1. Use the tray’s maximum-capacity label to determine how much 

media to load.

2. Load media with the side to be printed face-up.

3. Place the media snugly against the inside left back wall of 
the tray.

4. Set the switch on the side of the tray for Transparency or Label to 
match the loaded media. 

5. Insert the tray into the printer.  

6. In the printer driver, make these selections:

� Select the appropriate tray.

� Turn off the two-sided printing option.

0643-62
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Printing on High Resolution Photo Paper
The Tektronix High Resolution Photo Paper is printable on one side 
only, and has a Tektronix logo on the reverse.  

See page 1 for supplies ordering information.     

1. Insert the paper into the appropriate tray:      

Standard Paper/Transparency tray:  50 sheets 

� Load paper face-up 

� Set tray switch to Paper.    

Manual-feed slot:  1 sheet

� Load paper face-down  

2. In the printer driver, make these selections:

� Select the appropriate tray.

� Turn off the two-sided printing option.

� Select High-Resolution Photo as the TekColor color 
correction.  

3.  Send the job to the printer.

 

Photo Paper
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Printing on labels
1. Insert the label sheets into the appropriate tray:  

Standard Paper/Transparency tray:  50 sheets 

� Face-up 

� Set tray switch to Paper.      

High-Capacity Transparency/Label tray:  100 sheets

� Face-up   

� Set tray switch to Label.    

Manual-feed slot:  1 sheet

� Face-down   
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2. If your application has a setting for labels, use it as a template.  
Otherwise, for margin settings, refer to the instructions included 
with the labels.

3. In the printer driver, make these selections:

� Select the appropriate tray.

� Turn off the two-sided printing option.

4.  Send the job to the printer.

See page 1 for supplies ordering information.     

Guidelines for printing on labels
� Use only Phaser 850 printer Color Printing Labels.  

� If any of the labels on a sheet are missing, do not use that sheet; it 
may damage printer components.

Caution

Keep labels in a cool, dry place.  Never store labels in a 
high-humidity environment.  Labels stored under such 
conditions will jam in the printer. Store unused labels flat in 
their containers.  Rotate stock frequently.  Long periods of 
storage can cause the labels to curl and will jam the printer.

Labels
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Automatic two-sided printing 
Automatically make two-sided prints using the paper trays or the 
manual-feed slot.  In the Print dialog box, select the two-sided printing 
option and a binding preference (how the page turns).   

To automatically make two-sided prints:

� Do not place paper that was printed on one side back into the 
printer to print on the second side.  Pre-printed pages may stick 
together.  

� Make sure the Paper/Transparency switch on the tray is set 
to Paper.  

� Use only Letter- or A4-size paper.  

� When the printer operates in automatic two-sided printing mode, 
the paper partially exits before printing the second side.  To avoid 
paper jams, do not touch the paper before it completely exits the 
printer.

Caution

Two-sided printing is supported only for Letter- and A4-size 
papers within the 16 - 32 lb. range.  Make sure two-sided 
printing is off in the printer driver for all other paper types. 

  

Macintosh Drivers

LaserWriter 8.6 � From the File menu, select Print. 

� From the pull-down menu, select Layout.

� Select Print on Both Sides. 

� Select a binding preference.  

LaserWriter 8.3.4 � From the File menu, select Print. 

� Click the Options button.

� Select 2-Sided Printing.

� Select Short-Edge Binding or Long-Edge Binding.
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Binding preference  

 

PC Drivers

Windows 95 

Windows 98

� From the File menu, select Print.

� Click Properties.

� Click the Setup tab.

� Select Print on 2 sides.

� Check or uncheck Bind on top edge.

Windows NT4 � Start/Settings/Printers.

� Right-mouse-button-click on your printer’s icon.

� From the pop-up menu, select Document 
Defaults.

� Click the Advanced tab.

� Under Paper/Output, select Print on Both Sides.

� Select Long Side or Short Side.  

Landscape Portrait

Long
edge

Short
edge
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Loading letterhead paper for two-sided printing

To load letterhead paper for two-sided printing, follow these 
additional steps.     

Caution

Do not place paper that was printed on one side back into the 
printer to print on the second side.  Pre-printed pages may 
stick together.  

 

1. Load the paper in the paper tray or the manual-feed slot:   

� Paper tray
Letterhead side is face-down.
Place the top of the page at the back of the tray.  

� Manual-feed slot
Letterhead side is face-up.
Top of the page enters the printer last.  
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2. In your printer driver, in the Print dialog box, select the tray by 
location:  

� Upper

� Middle

� Lower

� Manual Feed Paper

Note

When the printer operates in automatic two-sided printing 
mode, the paper partially exits before printing the second 
side.  To avoid paper jams, do not touch the paper before it 
completely exits the printer.  
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Adding ink  
Caution

Use only Phaser 850 printer ColorStix® ink; the use of other 
ink may affect print quality and reliability.  Tektronix 
warranties and service contracts do not cover damage, 
malfunction or degradation of performance caused by the use 
of non-Tektronix supplies or consumables or the use of 
Tektronix supplies not specified for use with this printer.    

See page 1 for supplies ordering information.     

Ink tips:

� Keep ink in its packaging until you are ready to use it.

� To avoid ink jams, never insert broken ink sticks into the 
ink-loading bins.

Loading ink:

To load ink any time the printer is Idle, or when the front panel 
displays Ink low or Ink out, follow this procedure.  

1. Open the top cover.  A color-coded label inside the top cover 
corresponds to the color of each ink-loading bin.

2. Remove the ink stick from its packaging.
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3. Place the appropriate color ink stick into the ink-loading bin that 
appears low.  Do not force the ink sticks into the ink-loading bins.  

Each ink stick is uniquely shaped to fit into the correct 
ink-loading bin.  Insert the ink stick’s narrow end first. 

4. Close the top cover.  

The front panel may read Processing until the printer is ready for 
printing.   

0643-141.ai
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Emptying the waste tray
When the front panel displays Empty Waste Tray, follow this 
procedure. 

See page 1 for supplies ordering information.     

Caution

The printer’s interior may be hot. Do not reach into the 
printer while the maintenance drawer is removed.

1. Open the front cover.

2. Grasp the maintenance drawer, labeled as A, and pull it out of the 
printer.  

Note

The maintenance drawer may be locked while the ink 
cools after the front panel troubleshooting routine, 
Eliminate Light Stripes.  Make sure all covers are 
closed.  Wait 15 minutes before trying to remove the 
maintenance drawer.  The maintenance drawer may 
also be locked during the warm up cycle whenever the 
printer is turned on. 
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3. The waste tray may be hot; handle it carefully.
Lift the waste tray, labeled as B, from the maintenance drawer.  

4. Empty the waste tray by gently twisting the tray or tapping it on 
the sides of a waste container.  Ink is non-toxic and can be 
discarded as normal office waste.  

5. Replace the waste tray in the maintenance drawer.  Make sure the 
waste tray is seated flat in the maintenance drawer.  

6. Reinsert the maintenance drawer into the printer and close the 
front cover.  

1 2 3
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Replacing the Maintenance Kit
The Maintenance Kit is a consumable that consists of the maintenance 
roller and counter.  The kit is located in the Maintenance Drawer, 
labeled as A, behind the printer’s front cover.    

Detailed, illustrated instructions are included with each new 
Maintenance Kit.  See page 1 for supplies ordering information.  

The front panel displays these messages:    

� The Standard Maintenance Kit has a life of 10,000 prints or 
2 years, whichever comes first. 

� The Extended Maintenance Kit has a life of up to 45,000 prints 
(depending on ink coverage) or 2 years, whichever comes first.   

Front panel message Action

Maintenance Kit is low Order a replacement maintenance 
kit; replace the Maintenance Kit 
soon.

Replace Maintenance Kit Replace the Maintenance Kit to 
continue printing.

Make sure the new counter is 
installed.  

Maintenance Kit Missing Reinstall the counter or 
maintenance drawer.  

Preventative Maintenance: Replace
Maintenance Kit

Press the Help button on the front 
panel for details.   
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Caution

The printer may be hot. Do not reach into the printer 
while the maintenance drawer is removed. 
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Removing paper jams
The front panel message indicates the jam location and information on 
how to clear the jam.  Check the front panel for Troubleshooting Jams 
information.  

To prevent jams, use only the recommended papers, transparencies, 
and labels (see page 10), and clean the printer’s rollers if visibly dirty.  
For complete cleaning instructions, refer to the printer’s CD-ROM or 
on the Tektronix web site.  

Media Jam — Open Exit Cover to Clear  

Solution 1

If the paper has partially exited the printer at the exit slot, follow these 
steps.  Otherwise, refer to Solution 2 on page 43.

1. Open the exit cover.  

2. Using both hands, remove the jammed paper.  

3. Remove the entire sheet of paper; any pieces of paper left in the 
printer may cause more jams.

0643-71.ai
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Solution 2

If paper gets caught under the Rapid Release Guide, follow these steps.

Caution

Handle the Rapid Release Guide carefully to avoid bending 
or damaging the clear plastic edge.  

1. Open the exit cover.

2. Lift the blue paper guide.     

3. Lift up on the blue tabs and remove the Rapid Release Guide.  Do 
not use any sharp objects in this area of the printer.    

1
2
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4. Remove the jammed paper.  

5. Make sure the thin, white dust shield is lying on top of the metal 
shaft.  Then, reinstall the Rapid Release Guide, pressing down on 
the blue tabs to snap the guide into place.    

  

4
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Media Jam — Open front cover to clear  

1. Open the front cover.

2. Using both hands, remove the jammed paper.

3. If there is any resistance to removing the jammed paper, turn the 
blue thumbwheel to help feed the paper.   

4. Remove the entire sheet of paper; any pieces of paper left in the 
printer may cause more jams.

0643-72.ai
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Media Jam — Retry manual feed
 

1. Using both hands, remove the jammed paper, transparency, or 
label sheet.

2. When prompted by the display message, reinsert the sheet using 
both hands.   

Make sure you insert the sheet properly, so it enters the printer 
straight and evenly.  Be especially careful to properly line up 
envelopes and small-size papers.      

0643-158
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Media Jam — Remove media (or upper) tray to clear

  

1. Remove the paper tray (if your printer has more than one tray, 
pull out the upper tray).

2. Using both hands, remove the jammed paper.

0643-74.ai
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Media Jam — Remove middle tray to clear

Media Jam — Remove lower tray to clear

 

1. Remove the paper tray named in the front panel display.

2. Using both hands, carefully remove the jammed paper.

0643-75.ai



User Guide 49

Troubleshooting print quality

Light stripes or missing colors

Clean the printhead with the printer’s front panel troubleshooting 
routine.     

1. On the front panel, scroll to Menu. Press Select.

2. Scroll to Troubleshooting; press Select.

3. Scroll to Print Diagnostic Test Page; press Select.  These 
illustrations show a correct Test Page and an example of a 
Test Page with a missing color bar.

A.  Correct test page B.  Missing color bar

0643-56.ai

1 2 3 4 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61 62 63 64 65 66 67 68 69 70 71 72 73 74 75 76 77 78 79 80 81 82 83 84 85 86 87 885

6 7 8 9 10 11 12 13

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61 62 63 64 65 66 67 68 69 70 71 72 73 74 75 76 77 78 79 80 81 82 83 84 85 86 87 88

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61 62 63 64 65 66 67 68 69 70 71 72 73 74 75 76 77 78 79 80 81 82 83 84 85 86 87 88

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61 62 63 64 65 66 67 68 69 70 71 72 73 74 75 76 77 78 79 80 81 82 83 84 85 86 87 88

0643-135.ai

1 2 3 4 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61 62 63 64 65 66 67 68 69 70 71 72 73 74 75 76 77 78 79 80 81 82 83 84 85 86 87 885

6 7 8 10 11 12 13

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61 62 63 64 65 66 67 68 69 70 71 72 73 74 75 76 77 78 79 80 81 82 83 84 85 86 87 88

1 2 3 4 5 6 7 8 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61 62 63 64 65 66 67 68 69 70 71 72 73 74 75 76 77 78 79 80 81 82 83 84 85 86 87 88

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61 62 63 64 65 66 67 68 69 70 71 72 73 74 75 76 77 78 79 80 81 82 83 84 85 86 87 88

 

Print Q
uality



50 Phaser 850 Color Printer 

4. If the test print looks like example B in the illustration, go on to 
Step 5.

5. Scroll to Eliminate Light Stripes; press Select.

6. Check the test print that prints automatically, to confirm that the 
problem is corrected.  

7. Repeat Step 5 as necessary.  If light stripes persist after three 
consecutive clean cycles, turn off the printer for 4 hours to allow 
the ink to cool and solidify.  Then turn on the printer and repeat 
the clean cycles, if necessary.  

For more details, refer to the troubleshooting information on the 
printer’s CD-ROM or on the Tektronix web site.
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Oil or ink smears

Oil (drum fluid) on a print or ink smears on the front, back or 
edges of a page.   

 

Clean the printer’s internal paper path using the front panel 
troubleshooting routine.

1. Load the upper tray with sheets of clean, high-grade paper, 
preferably 120 g/m2; 32-lb.  This cleaning routine uses several 
sheets of paper.

2. On the front panel, scroll to Menu. Press Select.

3. Scroll to Troubleshooting; press Select.

4. Scroll to Remove Ink Smears; press Select.

5. If the problem persists, additional cleaning may be necessary.  For 
complete cleaning instructions, refer to the printer’s CD-ROM or 
on the Tektronix web site. 
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Ink streaks

Ink streaks or marks on the top edge, front or back of a page.

 

Clean the printer’s paper-exit path:  

� To clean the exit rollers, use a pre-soaked alcohol cloth.  

� To turn the rollers, use the blue thumbwheel.   

0643-60.ai
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Clean the Rapid Release Guide:  

1. Follow the steps in Solution 2 on page 43 to remove the Rapid 
Release Guide.  

2. Gently wipe the clear plastic Rapid Release Guide with a 
pre-soaked alcohol cloth. 

3. Reinstall the Rapid Release Guide, pressing down on the blue tabs 
to snap the guide into place.

0643-154
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Ink smears

Ink smears on the bottom edge of a page.

 

Clean the paper-feed rollers.

1. From the front panel, run the Remove Ink Smears routine; see 
page 51 for instructions.  

2. If smears remain, open the front cover and remove the 
maintenance drawer.

3. To clean rollers in rows 1, 2, and 3, use a pre-soaked alcohol 
cloth.  

4. To turn the rollers in rows 1 and 3, use the blue thumbwheel.  

5. Clean any ink from the polished metal guide located between 
rollers 1 and 2, using a presoaked alcohol wipe.  
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Moving the printer 

All moves

Follow these guidelines when moving the printer within the office and 
preparing it for shipment:

1. The printer must be cool before moving it; otherwise, ink spills 
may damage the printer.  Use this method:

a. Close all of the printer’s covers and doors.  

b. Turn off the printer.  Before the front panel goes blank (you 
have only 4 seconds),  select Shut Down For Moving Printer.  

c. The printer takes about 15 minutes to cool; during that time, 
the front panel reports its progress.  When the cool-down is 
complete, the front panel goes blank.  It is now safe to move 
the printer.

2. Removing the upper paper tray provides a place for your hands 
when lifting the printer.

3. Always move the printer separately from its High-Capacity Paper 
Tray Assembly. 
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Preparing the printer for shipment

Caution

Parts of the printer may be hot; to avoid personal injury, 
allow the printer to cool and use caution when handling it.

� Always repack the printer properly to ensure its safe shipment; 
refer to the instructions on the printer’s CD-ROM or on the 
Tektronix web site.

� Always remove the maintenance drawer (A) before shipment to 
avoid damage to the printer.  Place the drawer in a plastic bag for 
storage.  Never ship the printer with the maintenance drawer 
installed.  
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Getting help   
The printer's auto-running CD-ROM guides you to the various 
resources available for installing and learning more about your 
Tektronix color printer.  Use the CD-ROM to install your printer driver 
software, view and print user documentation, and watch "how to" 
videos.  Live Internet links on the CD-ROM let you access the 
Tektronix Color Connection web site, your single source for color 
education, interactive tutorials, free templates and support 
information.

Printer CD-ROM  
� Advanced Features and Troubleshooting Manual

� Consumables instructions

� Setup Guide poster

� Video help

� Networking manuals

� Cleaning instructions

� Repacking instructions

� Printer drivers

� Material Safety Data Sheets (MSDS)

Windows driver help system

Install the driver from the printer’s CD-ROM and use the embedded 
help system.

� Troubleshooting information

� Access to installed manuals and videos

� Live links to the Tektronix web site
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Color Connection    

colorconnection.tektronix.com

Color resource for tools and information to help you get the most out of 
your color printer:

� Customized support and automatic driver update notification.

� Color education with interactive tutorials and helpful hints.

� Free templates and promotions.

� Online supplies ordering

� Online documentation.

Printer’s front panel
� Help menu:  Accesses information and tools for solving printer 

problems. 

� Help button:  Press at any time for additional information on 
displayed menu options or status messages.   

� Troubleshoot Jams menu:  Appears when paper jams, provides 
additional information.  

Internal printer pages

The printer has several help pages available; refer to the Menu Map for 
their locations.  

� Connection Setup:  connecting to a computer or network

� Diagnostic Test Page:  how to solve print problems, such as 
smudges or light stripes

� Help Guide:  Provides specific help resources.

� Paper Tips Page:  what papers, transparencies, or labels to use

� Supplies Page:  part numbers and descriptions
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http://www.tek.com/cgi-bin/CPIDprinter?APP=CP&Model=Phaser+850&PAGE=Color&PgName=Color" target="_blank
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PhaserLink™ Software 

www.tek.com/Color_Printers/products/ phaserlink.html

� View printer status using any web browser

� Control printer settings

� Link to online documentation via the World Wide Web

� Receive electronic mail when consumables are low or other 
printer maintenance is required

� Requires network connection via TCP/IP

Tektronix web site 

www.tek.com/Color_Printers/

� Product and supplies information

� Finding your local reseller

TekSMART™ Knowledge Base 
www2.tek.com/TekSMART/

� Application issues

� Networking issues

� Printer errors

� Print quality issues

� Troubleshooting

� Latest tips from technical support

http://www.tek.com/Color_Printers/products/phaserlink.html
http://www.tek.com/Color_Printers/
http://www.tek.com/cgi-bin/CPIDprinter?APP=CP&Model=Phaser+850&PAGE=Color&PgName=TekSmart" target="_blank
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Other online services   

Customer Support Centers

Anonymous ftp server ftp.tek.com/Color_Printers/

Subscribe to email 
update notices

www.tektronix.com/Color_Printers/support/ 
subscribe.html 

Australia
1-800-811-177

Austria
0660 5804

Belgium
02 720 9602

Brazil
0800 16 0220

Canada
1-800-835-6100

China
10-6235-1230

Denmark
(44) 533 444

Eastern Europe and 
the Middle East
+44 1908 68187

Finland
0203 206 30

France
01 69 86 8137

Germany
0180 525 3535

Hong Kong
2585-6655

India (South Asia)
(91) 80-227-5577

Italy
02 45 287 000

Japan
81 3 3448 4872

Korea
2-528-4661

Luxembourg
400 847

Netherlands
(040) 267 0440

New Zealand
+61 2 9888 0100

Norway
22 723 801

Singapore (ASEAN)
1-800-356-5565

Spain
902 239 272

Sweden
(08) 299 071

Switzerland
01 212 2212

Taiwan
(02) 2757-1571

Thailand
2-645-4407

U. K.
(01) 908 681 707

U. S. 
1-800-835-6100
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Index

A
accessories

ordering information    1
adding ink sticks    36
Automatic color correction    9

B
Black and White color correction    9

C
cart for printer, ordering information    4
cleaning

for print quality    49
cleaning kit

ordering information    3
clearing paper jams (brief)    42
color corrections

Automatic    9
Black and White    9
Commercial Press    9
DIC    9
Euroscale Press    9
FujiProof    9
None    9
SNAP Press    9
sRGB Display    9
SWOP Press    9
Toyo    9
Vivid Color    9

ColorStix ink
loading    36
ordering information    1

Commercial Press color correction    9
consumables

adding ink sticks    36
Maintenance Kit    40
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D
DIC color correction    9
DP Feature Set, ordering information    4

E
Eliminate Light Stripes

brief procedure    49
Enhanced print quality mode    8
envelopes

guidelines    19
printing details    18
printing from Microsoft Word, Macintosh    19
printing from Microsoft Word, Windows    22
printing from the manual-feed slot    14
sizes    12

Euroscale Press color correction    9

F
Fast Color print quality mode    8
Feature Set, DP, ordering information    4
front panel

About My Printer    7
buttons    7
Help    7
introduction    6
Menu    7
Printer Demo    7

FujiProof color correction    9

H
hard disk, ordering information    4
High Resolution Photo

paper, ordering information    1
paper, printing on    29
print quality mode    8

High-Capacity Paper Tray Assembly
ordering information    4
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I
IDE hard drive, ordering information    4
information resources    57
ink sticks

loading    36
ordering information    1

J
jams, paper

brief procedure    42

L
labels

guidelines    31
ordering information    2
printing on    30
storing    31

light stripesbrief procedure    49

M
Maintenance Kit

ordering information    2
replacing    40

manual feed
2-sided printing    32
single-sided printing    14
supported media    13

margins
envelopes    12
paper    11

media
ordering information    1
tips    10

media jams
exit cover    42
front cover    45
manual feed    46
trays    47
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memory, printer, ordering information    3
modes

print quality    8
moving the printer    55

N
None color correction    9

O
online color resource    57

P
paper

jams (brief)    42
margins    11
ordering information    1
print area    11
sizes    11
tips    10

paper jams
exit cover    42
front cover    45
manual feed    46
trays    47

paper trays
ordering information    3

PhaserShare Token Ring network card, ordering information    5
print area

envelopes    12
paper    11

print quality modes    8
Enhanced    8
Fast Color    8
High Resolution/Photo    8
Standard    8

print speed    8
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printer
cart, ordering information    4
color corrections    9
feature set, ordering information    4
front panel    6
memory, ordering information    3
moving    55
print speed    8
quality modes    8
shipping    56
station, ordering information    4

R
Rapid Release Guide

cleaning (brief procedure)    53
ordering a replacement    3
paper jam    43

replaceable parts
ordering information    3

S
shipping the printer    56
smears

ink    54
oil or ink    51

SNAP Press color correction    9
speed of printing    8
sRGB Display color correction    9
Standard print quality mode    8
streaks, ink    52
supplies

order information    1
SWOP Press color correction    9

T
TekColor color corrections    9
Toyo color correction    9
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transparencies
ordering information    2
printing from standard tray    24
printing from Transparency/Label Tray    27
printing manual feed    14
sizes    11

transparency trays
ordering information    3

trays
high capacity    27
loading    24
optional assembly    25
ordering information    3
standard    23
Transparency/Label Tray    27

troubleshooting
light stripes, brief procedure    49
media jams    42
print quality problems (brief)    49
smears, ink    54
smears, oil or ink    51
streaks, ink    52

V
Vivid Color color correction    9
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